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Notice: Alicat Scientifi c, Inc. reserves the right to make any changes and improvements to the products 
described in this manual at any time and without notice. This manual is copyrighted. This document may 
not, in whole or in part, be copied, reproduced, translated, or converted to any electronic medium or machine 
readable form, for commercial purposes, without prior written consent from the copyright holder.
Note: Although we provide assistance on Alicat Scientifi c products both personally and through our literature, 
it is the complete responsibility of the user to determine the suitability of any product to their application.
Alicat Scientifi c, Inc.’s Wide-Range Laminar Flow Element Patent: The wide-range laminar fl ow element 
and products using the wide-range laminar fl ow element are covered by U.S. Patent Number: 5,511,416. 
Manufacture or use of the wide-range laminar fl ow element in products other than Alicat 

Limited Lifetime Warranty
Alicat Scientifi c, Inc. warrants to the original purchaser (hereinafter referred to as “Buyer”) that instruments 
manufactured by Alicat Scientifi c (hereinafter referred to as “Product”) shall be free from defects in materials 
and workmanship for the life of the Products.
Under this warranty, the Product will be repaired or replaced at manufacturer’s option, without charge for parts 
or labor when the Product is carried or shipped prepaid to the factory together with proof of purchase.
The foregoing shall constitute the exclusive and sole remedy in lieu of other remedies of the Buyer for any 
breach by Alicat Scientifi c of this warranty to the maximum extent permitted by law.
This warranty does not apply to any Product which has not been installed or used in accordance with the 
Product operation and installation specifi cations provided to Buyer verbally or in writing by Alicat Scientifi c for 
the proper and normal use of the Product.
Buyer agrees hereunder that Alicat reserves the right to void any warranty, written or implied, if upon Alicat’s 
examination of Product shall disclose to Alicat’s satisfaction that the Product failure was due solely, or in part, 
to accident, misuse, neglect, abuse, alteration, improper installation, unauthorized repair or improper testing 
by Buyer or agent of Buyer.
Alicat Scientifi c shall not be liable under any circumstances for indirect, special, consequential, or incidental 
damages in connection with, or arising out of, the sale, performance, or use of the Products covered by this 
warranty.
Alicat Scientifi c does not recommend, warrant or assume responsibility for the use of the Products in life 
support applications or systems.
Alicat’s warranties as herein above set forth shall not be enlarged, diminished or affected by, and no obligation 
or liability shall arise or grow out of Alicat’s rendering of technical advice in connection with Buyer’s order of the 
Products furnished hereunder.
If Product becomes obsolete, Alicat Scientifi c, at its own discretion, reserves the right to repair the Product 
with available replacement parts or upgrade the Product to a current , commercially available version of the 
original Product. Should upgrading the Product be deemed necessary by Alicat, Buyer hereby agrees to pay an 
upgrade fee equal to seventy percent of the retail value of the replacement Product. Alicat Scientifi c hereunder 
makes no claim that replacement Products will look, function or operate in the same or similar manner as the 
original product.
When a Product is returned to Alicat Scientifi c for recalibration this service is considered normal preventative 
maintenance. Recalibration of Product shall not be treated as a warranty service unless recalibration of Product 
is required as the result of repairs to Product pursuant to this Warranty. Failure to recalibrate Product on a 
yearly basis will remove any and all obligations regarding repair or replacement of Product as outlined 
by this Warranty to Buyer from Alicat Scientifi c.
This Warranty is in lieu of all other relevant warranties, expressed or implied, including the implied warranty 
of merchantability and the implied warranty of fi tness for a particular purpose, and any warranty against 
infringement of any patent.
Continued use or possession of Products after expiration of the applicable warranty period stated above shall 
be conclusive evidence that the warranty is fulfi lled to the full satisfaction of Buyer. 
Alicat makes no warranty as to experimental, non-standard or developmental Products.
Accessories purchased from Alicat are not covered by this warranty.
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Portable Calibration Unit
Thank you for purchasing an Alicat Scientifi c Portable Calibration Unit (PCU). Please take the time to 
fi nd and read the information contained in this manual. This will help to ensure that you get the best 
possible service from your instrument.
The Alicat Scientifi c Portable Calibration Unit (PCU) is designed to accurately measure gas fl ow rates 
of common gases with three separate fl ow meters with ranges determined by the end user’s needs. 
The laminar fl ow, differential pressure fl ow meters housed in the PCU are accurate and exceptionally 
repeatable devices, making the PCU an excellent portable secondary standard for fi eld fl owmeter 
calibration. 
The PCU’s three separate displays allow you to monitor Temperature, Absolute Pressure, Volume Flow 
Rate, and Mass Flow Rate simultaneously. The PCU is also equipped with an RS-232 output port that 
can be connected to a computer or other data-logging device. 

The Alicat PCU is designed for CLEAN, DRY, NON-CORROSIVE gases.

Connecting the PCU
The inlet and outlet connections to the PCU are located below the displays for their respective fl ow 
ranges (Figure 1). 
Inlet connections are located on the left and the outlet connections are located on the right (Figure 1.) 
The connections are either 1/8”, 1/4”, 3/8” or 1/2” push-connect style tubing fi ttings with each fi tting 
corresponding to a single fl ow range. Use appropriately sized plastic tubing to connect the fl ow source 
to the corresponding inlet fi tting. If necessary, connect the corresponding outlet fi tting to the original 
source destination with proper tubing. 
CAUTION: If the outlet fi ttings are not connected to your piping, the gas being measured will   
         vent to atmosphere at the outlet fi ttings! Use protective eyewear! 

Never Vent Flammable Gases To Atmosphere!

POWER
The PCU is designed to operate on either two 9 Volt Alkaline batteries or via a 9-20VDC power supply 
running at a minimum 100mA. The batteries should operate the PCU for 8 hours under normal usage.  
If the batteries drop below 7 volts, the replace battery light will come on and the batteries should be 
replaced or alternate power should be applied. 
When the replace battery light is on the accuracy of the meters’ readings cannot be guaranteed.

Application
Maximum operating line pressure is 145 PSIG (1000 kPa).

Caution: Exceeding the maximum specifi ed line pressure may cause permanent damage to the 
solid-state differential pressure transducer.

If the line pressure is higher than 145 PSIG (1000 kPa), a pressure regulator should be used upstream 
from the fl ow meter to reduce the pressure to 145 PSIG (1000 kPa) or less if possible. Although the 
meter’s operation is uni-directional, reversing the fl ow direction will infl ict no damage as long as the 
maximum specifi ed limits are not exceeded.

Note: Avoid installations (such as snap acting solenoid valves upstream) that apply instantaneous 
high pressure to the meter as permanent damage to the differential pressure sensor could result. 
This damage is not covered under warranty!
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Figure 1. PCU Controls and Connections

Note: Inlet and Outlet connection diameters may vary, depending on how the PCU is confi gured.

AC/DC Power Port
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Operating the PCU

The meter for each fl ow range on the PCU is controlled by its own set of Display/Control electronics 
located above the inlet and outlet ports of each fl ow range. The PCU meters can have several screen 
“modes” depending on how the device is ordered. All PCU meters have a default Main Mode, Select 
Menu Mode, a Gas Select Mode (the Gas Select Mode may not be available on meters calibrated for a 
custom gas or blend), a Communication Select Mode, a Manufacturuer Data Mode and a Miscellaneous 
Mode. In addition, your device may have been ordered with the optional Totalizing Mode (page 27). The 
device defaults to Main Mode as soon as power is applied to the PCU.

Main Mode

The main mode screen defaults on power up with the mass fl ow on the primary display. The following 
parameters are displayed in the main mode as shown in Figure 2.

MODE

  PSIA       oC            Tare
  +13.49      +22.73

      MASS
      SCCM
        Air
  

 +0.000        +0.000
 Volume          Mass      Main

Figure 2. Main Mode Display

 The “MODE” button in the lower right hand corner toggles the display between the Main display and 
the Select Menu display.

Tare – Pushing the dynamically labeled “Tare” button in the upper right hand corner tares the fl ow meter 
and provides it with a reference point for zero fl ow. This is a simple but important step in obtaining 
accurate measurements. It is good practice to “zero” the fl ow meter each time it is powered up. If the 
fl ow reading varies signifi cantly from zero after an initial tare, give the unit a minute or so to warm up 
and re-zero it.

If possible, zero the unit near the expected operating pressure by positively blocking the fl ow downstream 
of the fl ow meter prior to pushing the “Tare” button. Zeroing the unit while there is any fl ow will directly 
affect the accuracy by providing a false zero point. If in doubt about whether a zero fl ow condition exists, 
remove the unit from the line and positively block both ports before pressing the “Tare” button. If the unit 
reads a signifi cant negative value when removed from the line and blocked, it is a good indication that 
it was given a false zero. It is better to zero the unit at atmospheric pressure and a confi rmed no fl ow 
conditions than to give it a false zero under line pressure. 
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Once zeroed the PCU can now be used to check the calibration of other mass fl ow meters. Providing 
there are no leaks in the lines, the PCU can be used to check another mass fl ow meter either upstream 
or downstream of the PCU. 
Note: The PCU cannot be used to directly check volumetric fl ow meters (such as rotameters) because 
the density of the gas changes with the pressure drop present in all systems. 

Gas Absolute Pressure: The PCU fl ow meters utilize an absolute pressure sensor to measure the line 
pressure of the gas fl ow being monitored. This sensor references hard vacuum and accurately reads 
line pressure both above and below local atmospheric pressure. This parameter is located in the upper 
left corner of the display under the dynamic label “PSIA”. This parameter can be moved to the primary 
display by pushing the button just above the dynamic label (top left). The engineering unit associated 
with absolute pressure is pounds per square inch absolute (PSIA). This can be converted to gage 
pressure (psig = the reading obtained by a pressure gauge that reads zero at atmospheric pressure) by 
simply subtracting local atmospheric pressure from the absolute pressure reading:
   PSIG = PSIA – (Local Atmospheric Pressure)
The fl ow meters use the absolute pressure of the gas in the calculation of the mass fl ow rate. For 
working in metric units, note that 1 PSI = 6.89 kPa.

Gas Temperature: The PCU fl ow meters also utilize a temperature sensor to measure the line 
temperature of the gas fl ow being monitored. The temperature is displayed in engineering units of 
degrees Celsius (°C). The fl ow meters use the temperature of the gas in the calculation of the mass 
fl ow rate. This parameter is located in the upper middle portion of the display under “°C”. This parameter 
can be moved to the primary display by pushing the top center button above “°C”.

Volumetric Flow Rate: The volumetric fl ow rate is determined using the Flow Measurement Operating 
Principle described elsewhere in this manual. This parameter is located in the lower left corner of the 
display over “Volume”. This parameter can be moved to the primary display by pushing the “Volume” 
button (lower left). In order to get an accurate volumetric fl ow rate, the gas being measured must be 
selected (see Gas Select Mode). This is important because the device calculates the fl ow rate based on 
the viscosity of the gas at the measured temperature. If the gas being measured is not what is selected, 
an incorrect value for the viscosity of the gas will be used in the calculation of fl ow, and the resulting 
output will be inaccurate in direct proportion to the ratio between the two gases viscosities.

Mass Flow Rate: The mass fl ow rate is the volumetric fl ow rate corrected to a standard temperature 
and pressure (typically 14.696 psia and 25°C). This parameter is located in the lower middle portion 
of the display over “Mass”. This parameter can be moved to the primary display by pushing the button 
located below “Mass” (bottom center). The meter uses the measured temperature and the measured 
absolute pressure to calculate what the fl ow rate would be if the gas pressure was at 1 atmosphere and 
the gas temperature was 25°C. This allows a solid reference point for comparing one fl ow to another.

Flashing Error Message: Our fl ow meters and controllers display an error message (MOV = mass 
overrange, VOV = volumetric overrange, POV = pressure overrange, TOV = temperature overrange) 
when a measured parameter exceeds the range of the sensors in the device. When any item fl ashes 
on the display, neither the fl ashing parameter nor the mass fl ow measurement is accurate. Reducing 
the value of the fl ashing parameter to within specifi ed limits will return the unit to normal operation and 
accuracy.
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Select Menu Mode

Pushing “Mode” once will bring up the “Select Menu” display. Push the button nearest your selection to 
go to the corresponding screen. Push “Mode” again to return to the Main Mode display. (Note: If your 
meter was ordered with Totalizing Mode option (page 26), pushing the “Mode” button once will bring up 
the “Totalizing Mode” display. Pushing “Mode” a second time will bring up the “Select Menu” display.)

MODE

 Gas                 Misc
Select

SELECT
MENU

Comm.      Mfg.
RS-232     Data       Menu

Figure 3. Select Menu Display
Gas Select Mode
The gas select mode is accessed by pressing the button above “Gas Select” on the Select Menu 
display. The screen will appear as shown in Figure 4 below.

 PgUP      PgDWN     Main
  H2 Hydrogen
  He Helium
 >N2 Nitrogen
  N2O Nitrous Oxide
  Ne Neon
  O2 Oxygen
  UP        DOWN      Gas

MODE

Figure 4. Gas Select Display
The selected gas is displayed on the default main mode screen as shown in Figure 2, and is indicated 
by the arrow in the Gas Select Mode screen in Figure 4. To change the selected gas, use the buttons 
under “UP” and “DOWN” or above “PgUP” and “PgDWN” to position the arrow in front of the desired 
gas. When the mode is cycled back to the Main Mode, the selected gas will be displayed on the main 
screen. (Note: Gas Select Mode may not be available for units ordered for use with a custom gas or 
blend.)
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Communication Select

The Communication Select mode is accessed by pressing the button below “Comm. RS-232” on the 
Select Menu display. The screen will appear as shown in Figure 5 below.

Select

>
 Unit ID (A).....A
 Baud (19200)....19200
 Data Rate......Fast

Comm.
  UP       DOWN     RS-232

MODE

Figure 5. Communication Select Display

Unit ID – Valid unit identifi ers are letters A-Z and @ (see Note below). This identifi er allows the user 
to assign a unique address to each device so that multiple units can be connected to a single RS-232 
port on a computer. The Communication Select Mode allows you to view and/or change a unit’s unique 
address. To change the unit ID address, press the “Select” button in the upper left corner of the display 
until the cursor arrow is in front of the word “Unit ID”. Then, using the UP and DOWN buttons at the 
bottom of the display, change the unit ID to the desired letter. Any ID change will take effect when the 
Communication Select Screen is exited by pushing the MODE or Main button.

Note: When the symbol @ is selected as the unit ID, the device will go into streaming mode when 
the Communication Select Mode is exited by pushing the MODE or Main button. See the RS-232 
Communications chapter in this manual for information about the streaming mode.

Baud – The baud rate (bits per second) determines the rate at which data is passed back and forth 
between the instrument and the computer. Both devices must send/receive at the same baud rate in 
order for the devices to communicate via RS-232. The default baud rate for these devices is 19200 
baud, sometimes referred to as 19.2K baud. To change the baud rate in the Communication Select 
Mode, press the “Select” button in the upper left corner of the display until the cursor arrow is in front 
of the word “Baud”. Then, using the UP and DOWN buttons at the bottom of the display, select the 
required baud rate to match your computer or PLC. The choices are 38400, 19200, 9600, or 2400 baud.
Any baud rate change will not take effect until power to the unit is cycled.

Data Rate – Changing the Data Rate affects the rate at which the instrument dumps its data in the 
streaming mode. Slow is ½ the Fast rate. The speed of the Fast rate is determined by the selected 
baud rate. It is sometimes desirable to reduce the data rate if the communication speed bogs down the 
computer’s processor (as is not uncommon in older laptops), or to reduce the size of data fi les collected 
in the streaming mode. To change the data rate in the Communication Select Mode, press the “Select” 
button in the upper left corner of the display until the cursor arrow is in front of the word “Data Rate”. 
Then, using the UP and DOWN buttons at the bottom of the display, select either Fast or Slow. 
Any data rate change will be effective immediately upon changing the value between Fast and Slow.
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Manufacturer Data

“Manufacturer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display (Figure 
3). The “Mfg 1” display shows the name and telephone number of the manufacturer. The“Mfg 2” display 
shows important information about your fl ow meter including the model number, serial number, and 
date of manufacture. 

MODE

Main

Alicat Scientific, Inc.

Ph 520-290-6060
Fax 520-290-0109

Mfg 1

MODE

Main

Model M-10SLPM-D
Serial No 27117
Date Mfg.11/07/2009
Calibrated By.DL

Software GP07R23 
Mfg 2

Figure 6. Manufacturer Data Displays

Miscellaneous Mode
The Miscellaneous mode is accessed by pressing the button above the “Misc” label in the upper right 
hand corner of the Select Menu display. The screen will appear as shown in Figure 7. Push the button 
above “Select” to move the cursor even with the item you wish to adjust. Then use the “UP” and 
“DOWN” buttons to make the adjustment.

NOTE: All Miscellaneous changes are recorded when you exit the Miscellaneous display.
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MODE

Select    Main
>
LCD Contrast(10)   .  10
PVM DBand (0.5% FS)
PRESS Avg (008) . . . 008
FLOW Avg (100) . . . . 100

UP        DOWN      Misc

Figure 7. Miscellaneous Display
LCD Contrast: The Liquid Crystal Display Contrast can be adjusted between 0 and 30 with zero being 
the lightest contrast and 30 being the darkest contrast. To change the contrast, press the “Select” 
button in the upper left hand corner of the display until the cursor arrow is in front of the words “LCD 
Contrast (X)”. Then using the UP and DOWN buttons at the bottom of the display, change the contrast 
value as desired. The change is immediate and the effect can be monitored as the value is changed.
Display Zero Deadband: Zero deadband refers to a value below which the display simply jumps to 
zero. This deadband is often desired to prevent electrical noise from showing up on the display as minor 
fl ows or pressures that do not actually exist, especially in high noise (electrical) environments. This 
display deadband does not affect the analog or digital signal outputs — there is no zero deadband on the 
output signals. The display zero deadband can be adjusted between 0 and 3.2% of the Full Scale (FS) 
of the sensor. PVM refers to Pressure, Volumetric Flow and Mass Flow, the three parameters to which 
the deadband applies. To adjust the display zero deadband, press the “Select” button in the upper left 
hand corner of the display until the cursor arrow is in front of the words “PVM DBand (X %F.S.)”. Then 
using the UP and DOWN buttons at the bottom of the display, change the display zero deadband value 
as desired.
Pressure Averaging: It is sometimes advantageous to apply an averaging factor to the pressure output 
(and display) to make it easier to read and interpret rapidly fl uctuating pressures. Pressure averaging 
can be adjusted between 1 (no averaging) and 256 (maximum averaging). This is a geometric running 
average where the number between 1 and 256 can be considered very roughly equivalent to the 
response time constant in milliseconds. This can be very effective at “smoothing” high frequency process 
oscillations such as those caused by diaphragm pumps. To adjust the pressure averaging, press the 
“Select” button in the upper left hand corner of the display until the cursor arrow is in front of the words 
“PRESS Avg (XXX)”. Then using the UP and DOWN buttons at the bottom of the display, change the 
pressure averaging value as desired.
Flow Averaging: It is sometimes advantageous to apply an averaging factor to the fl ow output (and 
display) to make it easier to read and interpret rapidly fl uctuating fl ows. Flow averaging can be adjusted 
between 1 (no averaging) and 256 (maximum averaging). This is a geometric running average where 
the number between 1 and 256 can be considered very roughly equivalent to the response time constant 
in milliseconds. This can be very effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. To adjust the fl ow averaging, press the “Select” button in the upper 
left hand corner of the display until the cursor arrow is in front of the words “FLOW Avg (XXX)”. Then 
using the UP and DOWN buttons at the bottom of the display, change the fl ow averaging value as 
desired.
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RS-232 Output and Input 

Connect the male RS-232 DB9 port (See Fig. 1) of the PCU to the serial port of your computer or data 
logger. This will normally require a female/female DB9 cable (included).

One of the most common ways to access the RS-232 output from your PCU is through a simple terminal 
program. Open your Hyperterminal RS-232 terminal program (installed under the “Accessories” menu 
on all Microsoft Windows operating systems). Select “Properties” from the fi le menu. Click on the 
“Confi gure” button under the “Connect To” tab. Be sure the program is set for: 19200 baud and an 
8-N-1-None (8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol. Under the “Settings” tab, 
make sure the Terminal Emulation is set to ANSI. Click on the “ASCII Setup” button and be sure the 
“Send Line Ends with Line Feeds” Box is not checked, and that the “Append Line Feeds to Incoming 
Lines” box is checked. Those settings not mentioned here are normally okay in the default position. 
Type L, M or H to read data for the desired range. 

When the queried the window will fi ll with 6 columns of data representing the range (L=Low, M=Medium, 
H=High), absolute pressure, temperature, volumetric fl ow, mass fl ow, and selected gas respectively. 
Pressure units are PSIA, temperature units are Degrees C, volumetric fl ow units are Liters Per Minute, 
and mass fl ow units are Standard Liters Per Minute. The Low range is 0-2 SLPM, the Medium range is 
0-50 SLPM, and the High range is 0-1000 SLPM. 

L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR

PCU Mass Flow Meter Data Format
(Low Range)

Note: On units with the totalizer function the sixth column will be the totalizer value, with gas select 
moving to a seventh column.
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RS-232 Output and Input
Confi guring HyperTerminal®:

Open your HyperTerminal® RS-232 terminal program (installed under the “Accessories” menu on 1. 
all Microsoft Windows operating systems).
Select “Properties” from the fi le menu.2. 
Click on the “Confi gure” button under the “Connect To” tab. Be sure the program is set for: 19,200 3. 
baud (or matches the baud rate selected in the RS-232 communications menu on the meter) and 
an 8-N-1-None (8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.
Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI or Auto Detect.4. 
Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line Feeds” box 5. is not 
checked and the “Echo Typed Characters Locally” box and the “Append Line Feeds to Incoming 
Lines” boxes are checked. Those settings not mentioned here are normally okay in the default 
position.
Type L M or H to read data for the desired range.6. 
Save the settings, close HyperTerminal® and reopen it.7. 

In Polling Mode, the screen should be blank except the blinking cursor. In order to get the data streaming 
to the screen, hit the “Enter” key several times to clear any extraneous information. Type “*@=@” 
followed by “Enter” (or using the RS-232 communcation select menu, select @ as identifi er and exit the 
screen). If data still does not appear, check all the connections and com port assignments.

Tare –Tareing (or zeroing) the fl ow meter provides it with a reference point for zero fl ow. This is a simple 
but important step in obtaining accurate measurements. It is good practice to “zero” the fl ow meter each 
time it is powered up. A unit may be Tared by following the instructions on page 10 or it may be Tared 
via RS-232 input. 

To send a Tare command via RS-232, enter the following strings:

 In Polling Mode: Address$$V<Enter>    (e.g. B$$V<Enter>)

Collecting Data:
The RS-232 output updates to the screen many times per second. Very short-term events can be 
captured simply by disconnecting (there are two telephone symbol icons at the top of the HyperTerminal® 
screen for disconnecting and connecting) immediately after the event in question. The scroll bar can be 
driven up to the event and all of the data associated with the event can be selected, copied, and pasted 
into Microsoft® Excel® or other spreadsheet program as described below.

For longer term data, it is useful to capture the data in a text fi le. With the desired data streaming to the 
screen, select “Capture Text” from the Transfer Menu. Type in the path and fi le name you wish to use. 
Push the start button. When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from a text fi le can be pasted 
directly into Excel®. When the data is pasted it will all be in the selected column. Select “Text to 
Columns...” under the Data menu in Excel® and a Text to Columns Wizard (dialog box) will appear. 
Make sure that “Fixed Width” is selected under Original Data Type in the fi rst dialog box and click “Next”. 
In the second dialog box, set the column widths as desired, but the default is usually acceptable. Click 
on “Next” again. In the third dialog box, make sure the column data format is set to “General”, and click 
“Finish”. This separates the data into columns for manipulation and removes symbols such as the plus 
signs from the numbers. Once the data is in this format, it can be graphed or manipulated as desired. 

For extended term data capture see: “Sending a Simple Script to HyperTerminal®” on page 17.
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Data Format:
The data stream on the screen represents the fl ow parameters of the main mode in the units shown on 
the display. 

When the queried the window will fi ll with 6 columns of data representing the range (L=Low, M=Medium, 
H=High), absolute pressure, temperature, volumetric fl ow, mass fl ow, and selected gas respectively. 
Pressure units are PSIA, temperature units are Degrees C, volumetric fl ow units are Liters Per Minute, 
and mass fl ow units are Standard Liters Per Minute. The Low range is 0-2 SLPM, the Medium range is 
0-50 SLPM, and the High range is 0-1000 SLPM. 

L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR

PCU Mass Flow Meter Data Format
(Low Range)

Note: On units with the totalizer function the sixth column will be the totalizer value, with gas select 
moving to a seventh column.
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Gas Select – The selected gas can be changed via RS-232 input. To change the selected gas, enter 
the following commands:

 In Polling Mode: Address$$#<Enter>   (e.g. B$$#<Enter>)

Where # is the number of the gas selected from the table below. Note that this also corresponds to the 
gas select menu on the fl ow meter screen:

# GAS
0 Air Air
1 Argon   Ar
2 Methane   CH4
3 Carbon Monoxide  CO
4 Carbon Dioxide  CO2
5 Ethane  C2H6
6 Hydrogen  H2
7 Helium  He
8 Nitrogen  N2
9 Nitrous Oxide  N2O

10 Neon  Ne
11 Oxygen  O2
12 Propane  C3H8
13 normal-Butane  n-C4H10
14 Acetylene  C2H2
15 Ethylene  C2H4
16 iso-Butane i-C2H10
17 Krypton Kr
18 Xenon Xe
19 Sulfur Hexafl uoride SF6
20 75% Argon / 25% CO2 C-25
21 90% Argon / 10% CO2 C-10
22 92% Argon / 8% CO2 C-8
23 98% Argon / 2% CO2 C-2
24 75% CO2 / 25% Argon C-75
25 75% Argon / 25% Helium A-75
26 75% Helium / 25% Argon A-25
27 90% Helium / 7.5% Argon / 2.5% CO2

(Praxair - Helistar® A1025)
A1025

28 90% Argon / 8% CO2 / 2% Oxygen
(Praxair - Stargon® CS)

Star29

29 95% Argon / 5% Methane P-5

For example, to select Propane, enter: $$12<Enter>
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Sending a Simple Script File to HyperTerminal®
It is sometimes desirable to capture data for an extended period of time. Standard streaming mode 
information is useful for short term events, however, when capturing data for an extended period of 
time, the amount of data and thus the fi le size can become too large very quickly. Without any special 
programming skills, the user can use HyperTerminal and a text editing program such as Microsoft Word 
to capture text at user defi ned intervals.

1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS Word, you can tell how 

many lines you have by the line count at the bottom of the screen. The number of lines will correspond 
to the total number of times the fl ow device will be polled, and thus the total number of lines of data it 
will produce.

For example: A
 A
 A
 A
 A
 A
will get a total of six lines of data from the fl ow meter, but you can enter as many as you like.

The time between each line will be set in HyperTerminal.

4. When you have as many lines as you wish, go to the File menu and select save. In the save dialog 
box, enter a path and fi le name as desired and in the “Save as Type” box, select the plain text (.txt) 
option. It is important that it be saved as a generic text fi le for HyperTerminal to work with it.

5. Click Save.
6. A fi le conversion box will appear. In the “End Lines With” drop down box, select CR Only. Everything 

else can be left as default.
7. Click O.K.
8. You have now created a “script” fi le to send to HyperTerminal. Close the fi le and exit the text editing 

program.
9. Open HyperTerminal and establish communication with your fl ow device as outlined in the manual.
10. Set the fl ow device to Polling Mode as described in the manual. Each time you type A<Enter>, the 

meter should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell the program how often 

to read a line from the script fi le you’ve created. 1000 milliseconds is one second, so if you want a line 
of data every 30 seconds, you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” fi le you created.
18. Click Open.
19. The program will begin “executing” your script fi le, reading one line at a time with the line delay you 

specifi ed and the fl ow device will respond by sending one line of data for each poll it receives, when it 
receives it.

You can also capture the data to another fi le as described in the manual under “Collecting Data”. You 
will be simultaneously sending it a script fi le and capturing the output to a separate fi le for analysis.



18

Operating Principle

All PCU Gas Flow Meters are based on the accurate measurement of volumetric fl ow. The volumetric 
fl ow rate is determined by creating a pressure drop across a unique internal restriction, known as a 
Laminar Flow Element (LFE), and measuring differential pressure across it. The restriction is designed 
so that the gas molecules are forced to move in parallel paths along the entire length of the passage; 
hence laminar (streamline) fl ow is established for the entire range of operation of the device. Unlike 
other fl ow measuring devices, in laminar fl ow meters the relationship between pressure drop and fl ow 
is linear. The underlying principle of operation of the 16 Series fl ow meters is known as the Poiseuille 
Equation:

Q = (P1- P2)�r4/8ηL        (Equation 1)

Where: Q  = Volumetric Flow Rate
  P1  = Static pressure at the inlet
  P2 = Static pressure at the outlet
  r = Radius of the restriction
  η = (eta) absolute viscosity of the fl uid
  L = Length of the restriction

Since �, r and L are constant; Equation 1 can be rewritten as:

Q = K (∆P/η)          (Equation 2)

Where K is a constant factor determined by the geometry of the restriction. Equation 2 shows the linear 
relationship between volumetric fl ow rate (Q) differential pressure (∆P) and absolute viscosity (η) in a 
simpler form.

Gas Viscosity: In order to get an accurate volumetric fl ow rate, the gas being measured must be 
selected (see Gas Select Mode, page 9). This is important because the device calculates the fl ow rate 
based on the viscosity of the gas at the measured temperature. If the gas being measured is not what 
is selected, an incorrect value for the viscosity of the gas will be used in the calculation of fl ow, and the 
resulting output will be inaccurate in direct proportion to the difference in the two gases’ viscosities.

Gas viscosity, and thus gas composition, can be very important to the accuracy of the meter. Anything 
that has an effect on the gas viscosity (e.g. water vapor, odorant additives, etc.) will have a direct 
proportional effect on the accuracy. Selecting methane and measuring natural gas for instance, will 
result in a fairly decent reading, but it is not highly accurate (errors are typically < 0.6%) because 
natural gas contains small and varying amounts of other gases such as butane and propane that result 
in a viscosity that is somewhat different than pure methane.

Absolute viscosity changes very little with pressure (within the operating ranges of these meters) therefore 
a true volumetric reading does not require a correction for pressure. Changes in gas temperature do 
affect viscosity. For this reason, the PCU internally compensates for this change.
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Other Gases: PCU Flow Meters can easily be used to measure the fl ow rate of gases other than those 
listed as long as “non-corrosive” gas compatibility is observed. For example, a fl ow meter that has been 
set for air can be used to measure the fl ow of argon.

The conversion factor needed for measuring the fl ow of different gases is linear and is simply determined 
by the ratio of the absolute viscosity of the gases. This factor can be calculated as follows:
  Qog = Q1 [η1 / ηog ]

Where: Q1 = Flow rate indicated by the fl ow meter
  η1 = Viscosity of the calibrated gas at the measured temp.
  Qog = Flow rate of the alternate gas
  ηog = Viscosity of the alternate gas at the measured temp.

Say we have a meter set for air and we want to fl ow argon through it. With argon fl owing through the 
meter, the display reads 110 SLPM. For ease of calculation, let us say the gas temperature is 25°C. 
What is the actual fl ow of argon?

  Qog = Actual Argon Flow Rate
  Q1 = Flow rate indicated by meter (110 SLPM)
  η1 = Viscosity of gas selected or calibrated for by the meter at the
    measured temp.
  ηog = Viscosity of gas fl owing through the meter at the measured temp.

At 25°C, the absolute viscosity of Air (η1) is 184.918 micropoise.
At 25°C, the absolute viscosity of Argon (ηog) is 225.593 micropoise.

  Qog = Q1 (η 1 / ηog)
  Qog = 110 SLPM (184.918 / 225.593)
  Qog = 90.17 SLPM

So, the actual fl ow of Argon through the meter is 90.17 SLPM. As you can see, because the Argon gas 
is more viscous than the Air the meter is set for, the meter indicates a higher fl ow than the actual fl ow.

A good rule of thumb is: “At a given fl ow rate, the higher the viscosity, the higher the indicated fl ow.”

Volume Flow vs. Mass Flow: At room temperature and low pressures the volumetric and mass fl ow 
rate will be nearly identical, however, these rates can vary drastically with changes in temperature and/
or pressure because the temperature and pressure of the gas directly affects the volume. For example, 
assume a volumetric fl ow reading was used to fi ll balloons with 250 mL of helium, but the incoming 
line ran near a furnace that cycled on and off, intermittently heating the incoming helium. Because 
the volumetric meter simply measures the volume of gas fl ow, all of the balloons would initially be the 
same size. However, if all the balloons are placed in a room and allowed to come to an equilibrium 
temperature, they would generally all come out to be different sizes. If, on the other hand, a mass fl ow 
reading were used to fi ll the balloons with 250 standard mL of helium, the resulting balloons would 
initially be different sizes, but when allowed to come to an equilibrium temperature, they would all turn 
out to be the same size.

This parameter is called corrected mass fl ow because the resulting reading has been compensated 
for temperature and pressure and can therefore be tied to the mass of the gas. Without knowing the 
temperature and pressure of the gas and thus the density, the mass of the gas cannot be determined.
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Once the corrected mass fl ow rate at standard conditions has been determined and the density at 
standard conditions is known (see the density table at the back of this manual), a true mass fl ow can 
be calculated as detailed in the following example:

Mass Flow Meter Reading = 250 SCCM (Standard Cubic Centimeters/Minute)
Gas: Helium
Gas Density at 25C and 14.696 PSIA = .16353 grams/Liter
True Mass Flow = (Mass Flow Meter Reading) X (Gas Density)
True Mass Flow = (250 CC/min) X (1 Liter / 1000 CC) X (.16353 grams/Liter)
True Mass Flow = 0.0409 grams/min of Helium

Volumetric and Mass Flow Conversion: In order to convert volume to mass, the density of the gas 
must be known. The relationship between volume and mass is as follows:

Mass = Volume x Density

The density of the gas changes with temperature and pressure and therefore the conversion of 
volumetric fl ow rate to mass fl ow rate requires knowledge of density change. Using ideal gas laws, the 
effect of temperature on density is:

  ρa / ρs = Ts / Ta

Where: ρa = density @ fl ow condition
  Ta = absolute temp @ fl ow condition in °Kelvin
  ρs = density @ standard (reference ) condition
  Ts = absolute temp @ standard (reference) condition in °Kelvin
  ºK = ºC + 273.15  Note: ºK=ºKelvin

The change in density with pressure can also be described as:

  ρa / ρs = Pa / Ps

Where: ρa = density @ fl ow condition
  Pa = fl ow absolute pressure
  ρs = density @ standard (reference ) condition
  Ps = Absolute pressure @ standard (reference) condition

Therefore, in order to determine mass fl ow rate, two correction factors must be applied to volumetric 
rate: temperature effect on density and pressure effect on density.

Compressibility: Heretofore, we have discussed the  gases as if they were “Ideal” in their characteristics. 
The ideal gas law is formulated as: 

PV=nRT  where: P = Absolute Pressure
     V = Volume (or Volumetric Flow Rate)
     n = number moles (or Molar Flow Rate)
     R = Gas Constant (related to molecular weight)
     T = Absolute Temperature

Most gases behave in a nearly ideal manner when measured within the temperature and pressure 
limitations of Alicat products. However, some  gases (such as propane and butane) can behave in a 
less than ideal manner within these constraints. The non-ideal gas law is formulated as: 

PV=ZnRT

Where: “Z” is the compressibility factor. This can be seen in an increasingly blatant manner as  gases 
approach conditions where they condense to liquid. As the compressibility factor goes down (Z=1 is 
the ideal gas condition), the gas takes up less volume than what one would expect from the ideal gas 
calculation.
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This reduces to: Pa Va / Za Ta = Ps Vs / Zs Ts , eliminating R and n.

Alicat mass fl ow meters model gas fl ows based upon the non-ideal gas characteristics of the calibrated 
gas. The fl ow corrections are normally made to 25 C and 14.696 PSIA and the compressibility factor of 
the gas under those conditions. This allows the user to multiply the mass fl ow rate by the density of the 
real gas at those standard conditions to get the mass fl ow rate in grams per minute.

Because we incorporate the compressibility factor into our ‘full gas model’; attempts to manually 
compute mass fl ows from only the P, V, and T values shown on the display will sometimes result in 
modest errors. 

Note: Although the correct units for mass are expressed in grams, kilograms, etc. it has become standard 
that mass fl ow rate is specifi ed in SLPM (standard liters / minute), SCCM (standard cubic centimeters 
/ minute) or SmL/M (standard milliliters / minute).

This means that mass fl ow rate is calculated by normalizing the volumetric fl ow rate to some standard 
temperature and pressure (STP). By knowing the density at that STP, one can determine the mass fl ow 
rate in grams per minute, kilograms per hour, etc.

STP is usually specifi ed as the sea level conditions; however, no single standard exists for this 
convention. Examples of common reference conditions include:

    0°C and 14.696 PSIA
    25°C and 14.696 PSIA
    0°C and 760 torr (mmHG)
    70°F and 14.696 PSIA
    68°F and 29.92 inHG
    20°C and 760 torr (mmHG)

PCU Flow Meters reference 25ºC and14.696 PSIA (101.32kPa) - unless ordered otherwise. Refer 
to the calibration sheet to confi rm the reference point.

Standard Gas Data Tables: Those of you who have older Alicat products (manufactured before 
October 2005) may notice small discrepancies between the gas property tables of your old and new 
units. Alicat Scientifi c, Inc. has recently incorporated the latest data sets from NIST (including their 
REFPROP 7 data) in our products’ built-in gas property models. Be aware that calibrators that you may 
be spot checking against may be using older data sets such as the widely distributed Air Liquide data. 
This may generate apparent calibration discrepancies of up to 0.6% of reading on well behaved  gases 
and as much as 3% of reading on some  gases such as propane and butane, unless the standard was 
directly calibrated on the gas in question. As the older standards are phased out of the industry, this 
difference in readings will cease to be a problem. If you see a difference between the Alicat meter and 
your in-house standard, in addition to calling Alicat Scientifi c at (520) 290-6060, call the manufacturer 
of your standard for clarifi cation as to which data set they used in their calibration. This comparison will 
in all likelihood resolve the problem.
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Gas
Number Short Form Long Form

Viscosity*
25 deg C 

14.696 PSIA

Density**
25 deg C 

14.696 PSIA

Compressibility
 25 deg C 

14.696 PSIA
0 Air Air 184.918 1.1840 0.9997
1 Ar Argon 225.593 1.6339 0.9994
2 CH4 Methane 111.852 0.6569 0.9982
3 CO Carbon Monoxide 176.473 1.1453 0.9997
4 CO2 Carbon Dioxide 149.332 1.8080 0.9949
5 C2H6 Ethane 93.540 1.2385 0.9924
6 H2 Hydrogen 89.153 0.08235 1.0006
7 He Helium 198.457 0.16353 1.0005
8 N2 Nitrogen 178.120 1.1453 0.9998
9 N2O Nitrous Oxide 148.456 1.8088 0.9946

10 Ne Neon 311.149 0.8246 1.0005
11 O2 Oxygen 204.591 1.3088 0.9994
12 C3H8 Propane 81.458 1.8316 0.9841
13 n-C4H10 normal-Butane 74.052 2.4494 0.9699
14 C2H2 Acetylene 104.448 1.0720 0.9928
15 C2H4 Ethylene 103.177 1.1533 0.9943
16 i-C4H10 iso-Butane 74.988 2.4403 0.9728
17 Kr Krypton 251.342 3.4274 0.9994
18 Xe Xenon 229.785 5.3954 0.9947
19 SF6 Sulfur Hexafl uoride 153.532 6.0380 0.9887
20 C-25 75% Argon / 25% CO2 205.615 1.6766 0.9987
21 C-10 90% Argon / 10% CO2 217.529 1.6509 0.9991
22 C-8 92% Argon / 8% CO2 219.134 1.6475 0.9992
23 C-2 98% Argon / 2% CO2 223.973 1.6373 0.9993
24 C-75 75% CO2 / 25% Argon 167.451 1.7634 0.9966
25 A-75 75% Argon / 25% Helium 230.998 1.2660 0.9997
26 A-25 75% Helium / 25% Argon 234.306 0.5306 1.0002

27 A1025
90% Helium / 7.5% Argon / 

2.5% CO2 
(Praxair - Helistar® A1025)

214.840 0.3146 1.0003

28 Star29
90% Argon / 8% CO2 

/ 2% Oxygen 
(Praxair - Stargon® CS)

218.817 1.6410 0.9992

29 P-5 95% Argon / 5% Methane 223.483 1.5850 0.9993
*in micropoise (1 Poise = gram / (cm) (sec))    ** Grams/Liter          (NIST REFPROP 7 database)

Gas Viscosities, Densities and Compressibilities at 25° C
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Gas
Number Short Form Long Form

Viscosity*
0 deg C 

14.696 PSIA

Density**
0 deg C 

14.696 PSIA

Compressibility
 0 deg C 

14.696 PSIA
0 Air Air 172.588 1.2927 0.9994
1 Ar Argon 209.566 1.7840 0.9991
2 CH4 Methane 103.657 0.7175 0.9976
3 CO Carbon Monoxide 165.130 1.2505 0.9994
4 CO2 Carbon Dioxide 137.129 1.9768 0.9933
5 C2H6 Ethane 86.127 1.3551 0.9900
6 H2 Hydrogen 83.970 0.08988 1.0007
7 He Helium 186.945 0.17849 1.0005
8 N2 Nitrogen 166.371 1.2504 0.9995
9 N2O Nitrous Oxide 136.350 1.9778 0.9928

10 Ne Neon 293.825 0.8999 1.0005
11 O2 Oxygen 190.555 1.4290 0.9990
12 C3H8 Propane 74.687 2.0101 0.9787
13 n-C4H10 normal-Butane 67.691 2.7048 0.9587
14 C2H2 Acetylene 97.374 1.1728 0.9905
15 C2H4 Ethylene 94.690 1.2611 0.9925
16 i-C4H10 iso-Butane 68.759 2.6893 0.9627
17 Kr Krypton 232.175 3.7422 0.9991
18 Xe Xenon 212.085 5.8988 0.9931
19 SF6 Sulfur Hexafl uoride 140.890 6.6154 0.9850
20 C-25 75% Argon / 25% CO2 190.579 1.8309 0.9982
21 C-10 90% Argon / 10% CO2 201.897 1.8027 0.9987
22 C-8 92% Argon / 8% CO2 203.423 1.7989 0.9988
23 C-2 98% Argon / 2% CO2 208.022 1.7877 0.9990
24 C-75 75% CO2 / 25% Argon 154.328 1.9270 0.9954
25 A-75 75% Argon / 25% Helium 214.808 1.3821 0.9995
26 A-25 75% Helium / 25% Argon 218.962 0.5794 1.0002

27 A1025
90% Helium / 7.5% Argon

 / 2.5% CO2
(Praxair - Helistar® A1025)

201.284 0.3434 1.0002

28 Star29
90% Argon / 8% CO2 

/ 2% Oxygen
(Praxair - Stargon® CS)

203.139 1.7918 0.9988

29 P-5 95% Argon / 5% Methane 207.633 1.7307 0.9990
*in micropoise (1 Poise = gram / (cm) (sec))    ** Grams/Liter          (NIST REFPROP 7 database)

Gas Viscosities, Densities and Compressibilities at 0° C  
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TROUBLESHOOTING
Display does not come on or is weak.
Recharge the battery.

Flow reading is approximately fi xed either near zero or near full scale regardless of actual line 
fl ow.
Differential pressure sensor may be damaged. Avoid installations that can subject sensor to pressure 
drops in excess of 10 PSID. A common cause of this problem is instantaneous application of high-
pressure gas as from a snap acting solenoid valve upstream of the meter. Damage due to excessive 
pressure differential is not covered by warranty.

Displayed mass fl ow, volumetric fl ow, pressure or temperature is fl ashing and message MOV, 
VOV, POV or TOV is displayed:
Our fl ow meters and controllers display an error message (MOV = mass overrange, VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) when a measured parameter 
exceeds the range of the sensors in the device. When any item fl ashes on the display, neither the 
fl ashing parameter nor the mass fl ow measurement is accurate. Reducing the value of the fl ashing 
parameter to within specifi ed limits will return the unit to normal operation and accuracy.

Meter reads negative fl ow when there is a confi rmed no fl ow condition.
This is an indication of an improper tare. If the meter is tared while there is fl ow, that fl ow is accepted as 
zero fl ow. When an actual zero fl ow condition exists, the meter will read a negative fl ow. Simply re-tare 
at the confi rmed zero fl ow condition. Also note that while the meter is intended for positive fl ow, it will 
read negative fl ow with reasonable accuracy (it is not calibrated for bi-directional fl ow) and no damage 
will result.

Meter does not agree with another meter I have in line.
Volumetric meters will often not agree with one another when put in series because they are affected 
by pressure drops. Volumetric fl ow meters should not be compared to mass fl ow meters. Mass fl ow 
meters can be compared against one another provided there are no leaks between the two meters and 
they are set to the same standard temperature and pressure. Both meters must also be calibrated (or 
set) for the gas being measured. PCU mass fl ow meters are normally set to Standard Temperature 
and Pressure conditions of 25° C and 14.696 PSIA. Note: it is possible to special order meters with a 
customer specifi ed set of standard conditions. The calibration sheet provided with each meter lists its 
standard conditions.

Flow fl utters or is jumpy.
The meters are very fast and will pick up any actual fl ow fl uctuations such as from a diaphragm pump, 
etc. Also, inspect the inside of the upstream connection for debris such a Tefl on tape shreds. Note: PCU 
meters feature a programmable geometric running average (GRA) that can aid in allowing a rapidly 
fl uctuating fl ow to be read.

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter as voltage drops in the 
wires increase with distance. Using heavier gauge wires, especially in the ground wire, can reduce this 
effect.

RS-232 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the port on the computer to which 
the meter is connected is active. Confi rm that the port settings are correct per the RS-232 instructions 
in this manual (Check the RS-232 communications select screen for current meter readings). Close 
HyperTerminal® and reopen it. Reboot your PC.



25

Slower response than specifi ed.
PCU meters feature an RS-232 programmable Geometric Running Average (GRA). Depending on the 
full scale range of the meter, it may have the GRA set to enhance the stability/readability of the display, 
which would result in slower perceived response time. If you require the fastest possible response time, 
please consult the factory for written instructions on adjusting the GRA.
Jumps to zero at low fl ow.
PCU meters feature an RS-232 programmable zero deadband. The factory setting is usually 0.5% of 
full scale. This can be adjusted via RS-232 programming between NONE and 6.375% of full scale. 
Contact the factory for more information.
Discrepancies between old and new units.
Please see “Standard Gas Data Tables” explanation on page 21.

Maintenance and Recalibration
General: The PCU requires minimal maintenance. It has no moving parts. The single most important 
thing that affects the life and accuracy of these devices is the quality of the gas being measured. The 
meters are designed to measure CLEAN, DRY, NON-CORROSIVE gases. A 20 micron fi lter (50 micron 
for 50 LPM and up) mounted upstream of the meter is highly recommended. Moisture, oil, and other 
contaminants can affect the laminar fl ow elements and/or reduce the area that is used to calculate the 
fl ow rate. This directly affects the accuracy.
Recalibration: The recommended period for recalibration is once every year. Providing that the CLEAN, 
DRY, and NON-CORROSIVE mantra is observed, this periodic recalibration is suffi cient. A label located 
on the control panel of the device lists the recalibration due date. The device should be returned to the 
factory for recalibration near the listed due date. Before calling to schedule a recalibration, please note 
the serial number of the device. The Serial Number, Model Number, and Date of Manufacture are also 
available on the Manufacture Data 2 screen (page 11).
Cleaning: The PCU requires no periodic cleaning. The outside of the case can be washed as necessary.
The control panel and displays may be cleaned with a soft dry rag. Avoid excess moisture or solvents.
For repairs, recalibrations, or recycling of this product, contact:

Alicat Scientifi c, Inc.
7641 N Business Park Drive

Tucson, Arizona 85743
USA

Ph. 520-290-6060
Fax 520-290-0109

email: info@alicatscientifi c.com
Web site: www.alicatscientifi c.com
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Technical Data for the Alicat Portable Calibration Unit (PCU)
The following specifi cations are for the standard confi guration of the device. Please contact us or visit 
www.alicatscientifi c.com for customization details, application notes, etc.

Basic Specifi cation PCU Meters Description
Accuracy ± (0.4% of Reading ±0.2% of Full Scale) At calibration conditions after tare

Repeatability ± 0.2% Full Scale
Operating Range 1% to 100% Full Scale Measure and Control

Typical Response Time 10 Milliseconds (Adjustable)
Standard Conditions (STP) 25º C & 14.696PSIA Mass Reference Conditions

Operating Temperature −10 to + 50 º Celsius
Zero Shift 0.02% Full Scale / º Celsius / Atm

Span Shift 0.02% Full Scale / º Celsius / Atm
Humidity Range 0 to 100% Non – Condensing

Flow Rate 128% Measurable Full Scale
Maximum Pressure 145 PSIG

Input /Output Signal Standard RS-232 Serial & 0-5Vdc
Input / Output Secondary 0-5 Vdc; 0-10Vdc;4-20mA Pressure, Temperature or Flow

Warm-up Time < 1 Second

Wetted Materials 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced Nylon, Aluminum, 
Silicon, Glass.

Standard Full Scale Flow Ranges
0.5SCCM 100SCCM 50SLPM

1SCCM 500SCCM 100SLPM
2SCCM 1SLPM 250SLPM
5SCCM 2SLPM 500SLPM

10SCCM 5SLPM 1000SLPM
20SCCM 10SLPM 1500SLPM
50SCCM 20SLPM

No charge for alternate full scale ranges to increase 
accuracy (e.g. 2.5SLPM) or alternate units of measure (e.g. 
133SCFH).

Full Scale range applies for all 30 gases and mixtures in the 
calibration table.

Standard Pressure Drop Across the Device in PSID
Full Scale Flow

0.5SCCM to 1SCCM 1.0
2SCCM to 50SCCM, 1.0

100SCCM to 500SCCM 1.0
1SLPM 1.0
5SLPM 1.0

10SLPM 1.0
20SLPM 1.0
50SLPM 2.0

100SLPM 2.5
250SLPM 4.0
500SLPM 5.5

1000SLPM 6.0
1500SLPM 9.0

CCM CCH LPM LPH CFM CFH
CFH 0.0021 0.00003 2.1189 0.035 60.0 1.0
CFM 0.000035 0.0000005 0.035 0.00059 1.0 0.0166
LPH 0.06 0.001 60.0 1.0 1699.0 28.316
LPM 0.001 0.000017 1.0 0.0166 28.316 0.4719
CCH 60.0 1.0 60000.0 1000.0 1699011.0 28317.0
CCM 1.0 0.0167 1000.0 16.667 28317.0 471.947

Flow Conversion Table:
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Option: Totalizing Mode Screen

PCU Meters can be purchased with the Totalizing Mode option. This option adds an additional mode 
screen that displays the total fl ow (normally in the units of the main fl ow screen) that has passed through 
the meter or controller since the last time the totalizer was cleared. The Totalizing Mode screen shown 
below is accessed by pushing the “MODE” button until the label over it reads “Total”. If your meter is 
ordered with Totalizing Mode option, pushing the “Mode” button once will bring up the “Totalizing Mode” 
display. Pushing “Mode” a second time will bring up the “Select Menu” display. Pushing it a third time 
will return you to the Main Mode Sreen.

 Hours    Mass    Clear
    0.3     0.00

  Mass
  SLtr
  Air
   

MODE

Counter – The counter can have as many as six digdits. At the time of order, the customer must specify 
the resolution of the count. This directly affects the maximum count. For instance, if a resolution of 
1/100ths of a liter is specifi ed on a meter which is totalizing in liters, the maximum count would be 
9999.99 liters. If the same unit were specifi ed with a 1 liter resolution, the maximum count would be 
999999 liters.

Rollover – The customer can also specify at the time of order what the totalizer is to do when the 
maximum count is reached. The following options may be specifi ed:

No Rollover – When the counter reaches the maximum count it stops counting until the counter is 
cleared.

Rollover – When the counter reaches the maximum count it automatically rolls over to zero and continues 
counting until the counter is cleared.
Rollover with Notifi cation – When the counter reaches the maximum count it automatically rolls over to 
zero, displays an overfl ow error, and continues counting until the counter is cleared.

Hours.–.The display will show elapsed time since the last reset in 0.1 hour increments. The maximum 
measurable elapsed time is 6553.5 hours (about nine months). The hours count resets when the “clear” 
button is pushed, an RS-232 clear is executed or on loss of power

Clear – The counter can be reset to zero at any time by pushing the dynamically labeled “Clear” button 
located above the upper right side of the display. To clear the counter via RS-232, establish serial 
communication with the meter or controller as described in the RS-232 section of the manual. To reset 
the counter, enter the following commands:

 In Streaming Mode: $$T <Enter>

 In Polling (addressable) Mode: Address$$T <Enter>   (e.g. B$$T <Enter>)
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